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1. GENERAL INFORMATION

General Information 1
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Please read and follow these instructions carefully. All Quantum- 
Systems products are made for professional use only. 

With the purchase of a Quantum-Systems product you agree 
with the terms and conditions. The applicable terms and condi-
tions can be found at www.quantum-systems.com. These terms 
and conditions include regulations about liability and warranty.

Quantum-Systems GmbH reserves the right to make changes 
to specifications and product descriptions presented in this  
manual at any time without notice.

Applicable regulations 
When using Quantum-Systems products always follow local 
aviation regulations. Regulations can vary depending on the 
country and the region where the product is operated. Inform 
yourself about the applicable laws before using a Quantum-
Systems product.
“Beyond Visual Line of Sight” (BVLOS) operations might be pro-
hibited depending on the country or area. In some areas, the 
use of UAVs is completely prohibited. Inform yourself about the 
privacy laws concerning the use of Quantum-Systems products 
equipped with cameras. The use of the products and the com-
pliance of the regional laws is the operator’s sole responsibility. 

Technical support
For technical support please contact your sales agent. 

Quantum-Systems GmbH declares that the products: Vector & 
Scorpion UAV are in conformity with the CE regulations.

Address
Quantum-Systems, Inc.
11943 Discovery Court
Moorpark, CA 93021 - USA
www.quantum-systems.com 

™ SCORPION and VECTOR are registered trademarks of  
Quantum-Systems.
Powered by Auterion

Copyright © 2022 Quantum-Systems.  
All rights reserved.

Document number: 220421_BlueArc_Manual_V002
Release date: March 18th, 2022
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Abbreviations

ACC Acceleration
ADS-B Automatic Dependent Surveillance–Broadcast 
AGL Altitude Above Ground Level
ALT Altitude
AMC Auterion Mission Control
ATO Altitude Above Take-off
BVLOS Beyond Visual Line of Sight
ELV Elevation (height of ground above MSL)
EO Electro-Optical (Visible Light)
ESC Electronic Speed Controler
EVTOL Electric Vertical Take-off and Landing
FLT Flight Time
FPV First Person View
GCS Ground Control Station
GPS Global Positioning System
ID Identification
IMU Inertial Measurement Units
Incl Including
IR Infra-Red
LAT Latitude

General Information

LED Light-Emitting Diode
LON Longitude
MAG Magnetometer
MSL Altitude Above Mean Sea Level
POI Point of Interest
POS Position Mode
QS Quantum-Systems
REEST Reestablishing
RNG Ground Range (Distance on Ground)
RTR Retransition Waypoint
SBP Smart Battery Pack
SoC State of Charge

Sorpion
SR Slant Range (Direct Distance)
STBY Standby
UAS Unmanned Aerial System
UAV Unmanned Aerial Vehicle
UDP User Datagram Protocol
VTOL Vertical Take-off and Landing

 Vector

1
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The purpose of this guide is to equip the operator with the basic knowledge 
necessary to assemble the system, conduct mission planning and pre-flight 
operations, control the Unmanned Aerial Vehicle (UAV) in flight, respond to 
emergency conditions, and conduct post-flight operations. 

The following subjects are outside the scope of this guide:
•	 Tactics, Techniques, and Procedures
•	 Crew Resource Management
•	 Airspace authorizations and airspace management
•	 Advanced operations

Always follow local rules and Standard Operating Procedures.

Disposal
For the disposal of the battery packs, follow the local regulations for 
the recycling of Li-Ion batteries. Do not dispose the battery pack with 
the normal trash. Make sure the battery is completely discharged be-

fore the disposal. 
Before disposal apply the protection caps to the contacts. Never put the 
battery pack into fire due to the risk of an explosion. The battery can also be 
sent back to an official reseller or to Quantum-Systems. Dispose all Quan-
tum-Systems products according to the local regulations for the recycling 
of electronic or electrical devices. The outer wings and the elevator of the 
UAV can be disposed along with plastic waste.
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2. SAFETY INTRUCTIONS

2
Safety Instructions
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Battery Safety
To avoid fire, serious injury and property damage observe the following 
safety guidelines when using, charging or storing the UAV battery packs. 

Battery Handling
	 1. Do not take-off with State of Charge below 50%.
	 2. Do not use or charge swollen, leaky, or damaged batteries.
	 3. �Do not use a battery that was involved in a crash or any kind of heavy 

impact.
	 4. �The temperature of the battery pack must be within the operating tem-

perature range: 20 – 40 °C (68 – 104 °F). The vehicle will initiate battery 
heating in case the battery temperature is too low. 

	 5. �Do not expose the battery pack to direct sunlight. Temperatures over 
70 °C (158 °F) may damage the battery pack. To prevent malfunction of 
the battery, never fly the UAV in strong electrostatic or electromagnetic 
environments.

	 6. �Do not expose the battery to water. Replace the battery pack if exposed 
to water.

	 7. �If your eyes or skin make contact with any battery chemicals, immediate-
ly wash the affected area with clean running water for at least 15 minutes. 
See a doctor immediately.

	 8. �Do not place the UAV battery packs in a microwave, dryer, oven or in a 
pressurized container. Do not solder on or close to a UAV battery pack. 
Do not place the battery pack near a cooking surface, iron or radiator.

	 9. Do not drop the battery pack. Do not step on it.
10. Never open or modify the battery pack. Do not short circuit the battery.
11. The battery life may be reduced if it is not used regularly.
12. ��Avoid touching the battery pack surface directly after the flight. HOT! 

RISK OF BURNS!
13. �Never disassemble, puncture, shock, incinerate, or heat the battery pack 

over 70°C (158 °F).

Battery Charging 
	 1. �To charge the battery follow the guideline as described in this manual.
	 2. �Always use the original battery charger to charge the battery packs. 

Quantum-Systems is not responsible or liable for damages caused by 
charging the battery with a third-party charger.

	 3. �Only charge the batteries at ambient temperatures of 5 °C to 30 °C  
(41 °F - 86 °F).

	 4. �Never connect the battery packs to a wall socket or to car charger outlets 
directly.

	 5. �The battery must be charged under supervision. Never charge the bat-
tery pack close to flammable materials or on flammable surfaces.

	 6. Disconnect the battery when it is fully charged.
	 7. Do not clean the charger with flammable liquids like denatured alcohol.
	 8. Never use a damaged charger.

Battery Storage
	 1. �Keep the battery out of reach of children and animals. Do not leave the 

battery near heat sources such as furnaces or heaters.
	 2. �Always store the battery at proper ambient temperature: Storage less 

than 3 months: -20 °C to 45 °C (-4 °F to 113 °F) Storage more than 3 
months: 22 °C to 28 °C (72 °F to 82 °F).

	 3. Always keep the battery dry. Do not expose the battery to water.
	 4. �Never attempt to travel with or transport a damaged battery or a bat-

tery with a power level higher than 25 %.
	 5. Do not store the battery completely discharged.
	 6. Always remove the battery from the UAV when it is not in use.
	 7. Always apply the contacts protection cap if the battery pack is not in use.
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Operation
	 1. �Always follow the manual when using the system.
	 2. �It is the user’s responsibility to follow the laws that regulate the operation 

of UAS in the desired flying area. Flying out of the operator's sight might 
be prohibited depending on the local laws, please inform yourself.	

	 3. �Please always keep a safe distance from spinning rotors of at least  
10 m (33 ft) to avoid risk of injury and damage of property.

	 4. ��Please keep a safe distance between the UAV and humans at any time 
to avoid any personal injury in the event of a crash. 

	 5. �In case of an emergency the user must be able to manually fly the UAV. 
	 6. �Do not fly or take off close to objects generating magnetic/electroma-

gnetic fields (power lines, generators, antennas, transformers, etc.) as it 
may cause malfunction of the GPS and/or the magnetic field sensors.

	 7. �Do not fly or take off close to objects containing large amounts of metal 
or carbon fiber (parking decks, buildings of reinforced concrete, ships, 
cars or other machines) as it may cause malfunction of the GPS and/or 
the magnetic field sensors.

	 8. �Always ensure proper GPS coverage of the UAV. Do not fly in narrow 
canyons as it may cause malfunction of the GPS and/or the magnetic 
field sensors.

	 9. �Make sure no large obstacles (buildings, trees, mountains, etc.) or ob-
jects generating or blocking electro-magnetic radiation (antennas, fen-
ces, power lines, etc.) are between the transmitter / GCS and the UAV 
during the whole time of operation.

10. �The aircraft must not be operated  
• at temperatures below -12 °C (10.4 °F) and above 50 °C (122 °F).  
• in heavy rain or heavy snowfall. 
• �at windspeeds above 10 m/s (17.5 kn) on surface level. Please note 

that the wind speed on the ground is always less than the wind 
speed at flight altitude. 

11. �Transportation of the system is recommended in the original Quantum-
Systems transportation box.

12. �The use of third party products, such as batteries, chargers, ground mo-
dems, ground control stations, which were not provided by Quantum-
Systems, is prohibited. Any modification to the system is prohibited un-
less expressly authorized by Quantum-Systems or an authorized reseller.

13. �Due to the risk of an electric shock, do not disassemble any Quantum-
Systems product. For repair and maintenance work always contact your 
sales agent. 

14. �Each operator is responsible for ensuring the airworthiness of the UAV.
15. �The UAV does not detect and avoid obstacles. Every operator is  respon-

sible to plan a flight path that is free of obstacles. 
16. �Do not fly with detached payload.
17. �The equipment is for professional use only. It must not be operated by 

children.
18. Use only those batteries specified by Quantum-Systems.
19. The UAV and its ground-equipment must be stored inside its transport-
         box when not in use. The safety of the vehicle is not affected by UV radia-
       tion within the usual exposure time when handled accordingly.
 

2
Safety Instructions
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3. TECHNICAL SPECIFICATIONS

Technical Specifications

3
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Vector 
Max. Take-off Weight 7.4 kg / 16.3 lb
Max. Flight Time 120 min
Max. launch/landing altitude 3000 m / 9842 ft  MSL

Maximum operation altitude 4000 m / 13123 ft MSL

Command, control and video 
range 

15 – 25 km / 9.3 – 15.5 mi  
(Ground link dependent)

Cruise Speed Range 15 – 20 m/s / 29 – 39 kn
Optimal Cruise Speed 15 m/s / 29 kn 
Wind Resistance (ground) 10 m/s / 19.4 kn
Wind Resistance (cruise) 12 m/s / 23.3 kn
Wingspan 2.80 m / 9.2 ft

Backpack size 80 x 54 x 34,5 cm 
(31.5"x 21.3"x 13.6")  

Backpack weight 9.2 kg / 20.3 lb  
Cover incl. foam inlay

Scorpion 
Max. take-off weight <7 kg / <15.4 lb
Max. flight time 45 min
Max. launch/landing altitude 3000 m / 9842 ft MSL

Maximum operation altitude 4000 m / 13123 ft MSL

Command, control and video 
range 

15 – 25 km / 9.3 – 15.5 mi  
(Ground link dependent)

Cruise speed range 0 – 15 m/s / 0 – 29 kn
Wind resistance (ground) 10 m/s / 19.4 kn

Wind resistance (cruise) 10 m/s / 19.4 kn 
(gusts:12 m/s / 23.3 kn)

Wingspan without propellers 0.85 m / 2.8 ft
Length 1.37 m / 4.5 ft

Backpack size 76,5 x 38 x 28,5 cm 
(30.1" x 14.9"x 11.2") 

Backpack weight 5.7 kg /12.6 lb  
Cover incl. foam inlay

Operation temperature -20°C to +45°C / -4°F to +113°C

Average power consumption ~550W

Maximum power consumption 1.200W

Battery system
Quantum-Systems 
Smart Battery Pack                                       
7S5P Li-Ion 25,4V/15.600mAh

Operation temperature -20°C to +45°C / -4°F to +113°C

Average power consumption 165–185W

Maximum power consumption 2.700W

Battery system
Quantum-Systems 
Smart Battery Pack                                             
7S5P Li-Ion 25,4V/15.600mAh
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3
Payload
HD40-LV - Gimbal  

Zoom EO: �10x optical,  
2x digital IR: 4x digital

Resolution EO: 1280 x 720 IR: 640x480
Data rate 5 Mb/s (H264)
Power consumption 15 W
Weight 600 g / 1.3 lb
MISC KLV-Stream, GeoLock, Image stabilization

Skynav Tablet
Operating system Windows 10 Pro

CPU Intel® Core™ i5-7Y57  
vPro-Processor

RAM 8 GB RAM 

Screen resolution 7" LC-Display 1280 x 800
(up to 700cd/m2)

Graphics Intel® HD Graphics 615
Operating time w/o extra battery ~ 8h
Operating time w/ extra battery ~ 18h with 4-cell battery
Mission planning software Auterion Mission Control

Data Link
Frequency 2.0 – 2.5 GHz
Output Power 4 W
Range 15 km / 9.3 mi

Modem weight 1.18 kg  
(incl. antennas, battery and cable)

Operating time/battery set up to 12 hrs
Encryption AES 128/256

Technical Specifications
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4. COMPONENTS

4

Components
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SCORPION KIT 
•	 �Tri-copter kit for small & 

stationary surveillance 
missions 

•	 �Shares main body  
with the Vector

SURVEILLANCE SYSTEMS

Payload
•	 HD40-LV
 
		   

VECTOR  

•	 �eVTOL fixed wing UAV  
for long endurance  
surveillance missions  

•	 �Main body & eVTOL  
fixed-wing kit

Components
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SKYNAV TABLET
•	 �Incl. AMC software for  

mission planning & mission controlling 
•	 Incl. power cable  

TRANSPORT BOX / NICE-FRAME

•	 �Available for Vector & Scorpion
•	 �Niceframe – Backpack carrying  

system (optional)

DATA LINK (SILVUS)

•	 �Modem for 15 km range  
between Skynav tablet & the 
UAV 

•	 �Incl. cable for the  
Skynav tablet connection 

•	 �Incl. two battery packs &  
charging station 

•	 �Suction mount  
(optional)

4

Components
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18x nuts

Contact 
cleaning 
pen

18x bridges

SMART BATTERY PACK

ACCESSORIES KIT

UPDATE HARNESS
•	 1 Update harness
•	 1 Reset pin  

SBP TRANSPORT CASE
•	 Suitable for 2 battery packs  

SBP CHARGER

REACTIVATING KIT
•	 3-times reactivating kit
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5. ASSEMBLY & 
    TRANSPORT

5

Assembly, Disassembly & Transport
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2-in-1 System

CENTERPIECE
(Main body)
•	 EO / IR gimbal
•	�� Mesh IP encrypted  

data link
•	� Quantum-Skynode

SCORPION™
•	 Take-off weight: 		 < 7 kg / < 15.4 lb	
•	 Wingspan incl. rotors: 	 1.37 m / 4.5 ft

VECTOR™
•	 Take-off weight:	7.4 kg / 16.3 lb
•	 Wingspan: 	 2.80 m / 9.2 ft
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The QS Smart Battery Pack (SBP) is a Vector/Scorpion custom designed Li-Ion power source. It will enable you to maximize the 
performance and safety of your Vector/Scorpion missions.

Transport configuration and operational mode

You will receive your SBP in transport configuration. This ensures the battery can travel safely and follow transport regulations by 
physically splitting it into modules of less than 100 Wh. 

To be able to use the SBP it must be set to operational mode:
1. �Unscrew the 2 nuts and remove the red Transportation Lid .  

The self-locking nuts may not be used twice!
2. �Use the contact cleaning pen to clean the contacts of the six bridges and the contacts of the battery .
3. �Insert the 6 SBP bridges into the slots and screw new nuts back on  (use the included 0.9 Nm torque wrench).
4. When assembling the bridges, follow the order on m.
5. �Press the reset button and the program button on the bottom of the battery with the reset pin. 
6. The Status LED will start flashing for 60 seconds.
7. �Press the Start-Button before inserting the battery into the aircraft. The battery will turn off after 60 seconds if not installed.

Note: �If you are planning to send a SBP simply remove the bridges, re-install the red Transportation Lid and do not forget to 
send the bridges in the package.  

The Vector package includes 600 self-locking nuts to ensure 100 SBP bridge assembly/disassembly cycles. 
The self-locking nuts may not be used twice!
The cleaning process is always necessary after removing the red Transportation Lid and before assembling the 
bridges.

Battery setup

5

Assembly, Disassembly & Transport
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

Bridges

New nuts


Bottom of bridges
(contacts)

Contacts

180°

Contact 
cleaning 
pen

Transportation 
Lid (red)





SN
 X

XX
XX

1 3 5

2 4 6

7

8
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Vector backpack

The backpack is suitable for transporting all Vector components, data link, Skynav tablet and cables . The Smart Battery Packs 
must be carried in an extra bag. 

Please unpack in the following order.  
Layer overview	            Outside Compartment

Outside 
Compartment

Top LayerMiddle LayerBottom Layer

1. Skynav tablet

2. Data Link (Groundlink)

Middle layer

5. Payload 
6. Airspeed sensor 

4. Rear fuselage 
3. Main body 

5

Assembly, Disassembly & Transport
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Top layer

7. Left inner wing 

8. Left outer wing  

Bottom layer

10. �Right  
outer wing

11. Elevator

9. Right inner wing

	
Please follow the reverse order for packing and note that each part has a symbol corresponding to the symbol in the  
transportation box.
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Scorpion backpack

The backpack is suitable for transporting all Scorpion components, Data Link, Skynav Tablet and Cables . The Smart Battery 
Packs must be carried in an extra bag. 

Layer overview Outside Compartment
Outside Compartment

Main Layer

1. Skynav Tablet

2. �Data Link  
(Groundlink)

Main layer

3. Main body
4. Tailboom

5. �Arm  
left

7. Payload 
8. Airspeed sensor 

6. Arm right

Please follow the reverse order for packing and note that each part has a  
symbol corresponding to the symbol in the transportation box.

5

Assembly, Disassembly & Transport
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Lock mechanisms

All connections between the UAV parts are secured by the Vector/Scorpion lock mechanism. When connecting please make 
sure that the lock mechanism is locked properly. An audible click is noteable when the mechanism is in place.

closed open open open openclosed

1. Open the connector by gently pushing the shown button.
2. Connect the two parts and insert the connection hook into the corresponding mount.   
3. Secure the connection by locking the mechanism. An audible click is noteable when the mechanism is in place.
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Assembly, Disassembly & Transport

Vector assembly

Backpack Middle Layer 
 Place the main body on a level and stable surface.
 Attach the rear fuselage.
 Attach the payload.
 Attach the airspeed sensor.

Backpack Top Layer
 Attach the left inner- and outer-wing.

Backpack Bottom Layer
 Attach the right inner- and outer-wing. 
 Attach the elevator.

 Remove the battery cover.
 Press the Start/SOC-Button on the bottom of the Smart Battery Pack to activate the battery. Insert the Smart Battery Pack and 	
     attach the cover to secure the battery. The Vector will power automatically. 

The AMC configuration will be set to Vector automatically. Please check the compass rose in AMC to confirm. 

5
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Scorpion assembly

 Place the main body on a level and stable surface.
 Attach the rear fuselage.
 Unfold the propellers until they are in line.
 Attach the left and right arms. 
 Unfold the propellers until they are in line.
 Attach the payload.
 Attach the airspeed sensor.	
 Remove the battery cover.
 Press the Start/SOC-Button on the bottom of the Smart Battery Pack to activate the battery. Insert the Smart Battery Pack and 
attach the cover to secure the battery. The Scorpion will power automatically.

The AMC configuration will be set to Scorpion automatically. Please check the compass rose in AMC to confirm. 
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5

Data-Link assembly

 
 �Remove the (yellow) caps from the antenna connectors on the top side of the main part. 
 �Connect both antennas to the handheld main part. Lock them with the screw –  

lock mechanism.  
 �Connect the battery to the handheld main part. Lock it by the twist–lock mechanism.  
 �Connect the Data Link to the Skynav tablet with the included cable. 
 Start the AMC software on the Skynav tablet.

TIP: When controlling/monitoring the UAV on the go it is possible to insert the 
handheld into the corresponding slot on the top of the backpack. 

Assembly, Disassembly & Transport
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Connection manager

Once a particular Skynav and Vehicle are paired, link between the two will automatically be established when the system is 
powered on and AMC is opened (may take up to 90 seconds). In case the connection is not established automatically, it is 
possible to pair the vehicle, data link and Skynav manually.

1.  �Activate the Smart Battery Pack by pressing the SoC Button on the battery.

2.  �Power on Vector/Scorpion
a. Insert Smart Battery Pack with the arrow facing forward.
b. Install battery cover and secure both latches.
c. Ensure radio profile dial is set to position 1.

3.  �Power on Skynav and Silvus Ground Radio.
a. Log in to your Skynav . 
b. Turn the knob on the Silvus Ground Radio to position 1.

4.  �Open AMC on Skynav 
          

5.  �Select Connection icon  
The Connection Manager will open. To change and verify the 
settings click on the settings button. 
a. The connection type should be set to "Silvus".
b. The Modem IP should match with the IP address written on the Data Link housing.
c. The Netowrk ID is a 5 digit number (vehicle serial number by default).
Select "Apply".
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5

Assembly, Disassembly & Transport

6.  �In the connection manager you can either connect to previously paired vehicles or select "Pair another Vehicle".
     Note: The Modem-IP as well as the Network ID have to be set correctly to pair the particular vehicle.

7. If necessary, the TX Power and the Connect Channel can be changed in the Connection Manager.

NOTE: To set the Vehicle's Silvus Settings to factory settings press the pairing-button on the vehicle (next to the LEDs).
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6. CHARGING 6

Charging
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1.  �Connect the SBP charger to a power source (110 – 230 V AC).
2.  �Flip the power switch to turn on the charger. Three LEDs will light  

up indicating the charger is trying to detect a battery to charge. 
A green LED indicates the charger is powered. A yellow LED 
(Charging) and a green LED (Full) are flashing alternately.

3.  �Insert the SBP into the charging mount, matching the arrow direc-
tion of the battery and the charging station. The yellow flashing 
LED indicates the battery is charging.

4.  �Once the yellow flashing switches to permanently green the char-
ging is completed. Charging time: 1 – 1.5 hours. 

5.  �The battery can be removed by pulling the handle and the station 
can be turned off.

NOTE: If the charger is powered for too long without a battery, a red (error) light will 
flash. If this is the case turn off the charger, wait 20 seconds, turn it back on and and 
repeat from step 2.

Smart Batter Pack charging

Silvus battery charging

1. Make sure the battery is disconnected from the Data-Link.  
2. Connect the power supply to the charger.  
3. Connect the power cord to the power source.  
4. Insert up to two batteries into the charger. The charging process will start automatically.  
5. The successful charging process is indicated by green LEDs.
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Skynav battery charging 

1.  	Plug the Panasonic AC Charging Adapter into a 100-240V power source and connect it to the power port on the Skynav. 	
	 The power port is located on the inside-back of the left handgrip.

2.  	Once charging is complete, the battery indicator LED on the top-right of the Skynav’s screen will change from red to 		
	 green. Expect a battery life of 8 hours on a full battery.
	

6

Charging
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7. FLIGHT OPERATION
7

Flight Operation
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Status LED 
(green/red)

Program
button

Start
SoC/Heat

LED State of charge 
(green)

SoC/Heat

State of Charge
Reset

Reset
button

State of Charge (SoC) indicator

5 LEDs with 20 % increments show the SoC from 0 – 100 %. 
 
Press the Start SoC/Heat button on the bottom of the battery and a SoC will light 
up.

Current battery level Legend
LED 5 LED 4 LED 3 LED 2 LED 1 Status Symbol Explanation
     20 %  LED is off
     40 %  green LED is permanently on
     60 %
     80 %
     100 %

Manual pre-heating function

The SBP automatically heats up as soon as it is connected to the UAV. As it is safety relevant the UAV will not allow the preflight 
check if the battery temperature is below its operational temperature. 

The heating can be activated manually to allow for pre-heating during vehicle assembly: 
1. Press and hold down the button on the bottom of the battery for more than 8 seconds. 
2. The SoC LEDs will flash in sequence until the battery reaches optimal operation temperature. 
3. The heating will stop automatically (LEDs will stop flashing).

Battery operation
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General flight characteristics - Vector

This illustration describes the general flight operation of the Vector incl. the takeoff, transition, mission/Smart-Actions, backtran-
sition and landing. 

7

Flight Operation

Transition altitude

Base

Orbit 

3. Mission/Smart 
Actions

2. Transition

1. Takeoff
4. Backtransition5. Landing

Transition-Phase

VTOL: Hover configuration (Motors vertical)

VTOL: Fixed-wing configuration(Motors horizontal)
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General flight characteristics - Scorpion 

Mission / Smart Actions 

Start Mission / TakeoffArm 

Manual commands

This illustration describes the general flight operation of the Scorpion. It is possible to switch between manual commands, 
mission elements and smart actions during the flight.
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General flight characteristics

WARNING: During takeoff and landing, maintain a distance of at least 33 feet (10 meters) between Vec-
tor/Scorpion and personnel.  

Although Vector is a VTOL platform, there are performance limitations on how high it can climb and descend vertically. 
Therefore, Vector takeoffs are not always a simple matter of climbing vertically until above all nearby obstacles, transitioning 
from VTOL to forward, cruise flight, and proceeding with the mission.

Rather, the Vector must take off vertically to a maximum altitude of 98 feet (30 meters), transition to forward, cruise flight, and 
only then continue to climb as needed. Since it is not possible to climb vertically above 98 feet, careful mission planning is 
required in environments with tall trees, buildings, or varied terrain around the launch location.

For landings, the Vector must first descend to an altitude of 164 feet (50 meters) or below before back-transitioning to VTOL 
flight above the landing location and descending vertically to land. In order to descend down to 164 feet or below, the system 
uses a descent circle and a final approach leg into the landing location. This descent loop and approach leg must not collide 
with obstacles or terrain, so careful mission planning may also be required for landings.

The fastest and easiest method is to use Fly View to designate sectors around the landing location that are free of obstacles. 
However, some takeoff and recovery sites are so restrictive and full of obstacles that using the Fly View is not a viable option. 
In such cases, detailed mission planning in Plan View is required. 
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Flight modes

Near the upper-left corner of AMC, there is a Flight Mode dropdown-menu. In the example below, the Vector is in VTOL Take-
off flight mode

The Flight Mode icon serves two purposes

•	 Display the vehicle's current flight mode.
•	 When pressed, allows the user to select "Position" flight mode for manual control. In Scorpion configuration, the 
	 vehicle switches to position mode automatically if a joystick-input is detected.

Except to enter "Position" flight mode for manual control, the operator does not need to manually change flight modes during 
the course of a mission. Rather, the flight modes will change automatically based on the actions the operator takes in Fly View 
and Plan View. Nevertheless, for situational awareness purposes, it is useful for the operator to understand these flight modes.

VTOL Takeoff: 	 Flight mode during takeoff (Vector only).

Mission:		 Flight mode in which the Vector is navigating to mission items specified in Plan View. 

Hold: 		  Flight mode in which the Vector is executing Fly View tasks (e.g. Orbit). Also the flight mode when the user 
		  manually commands "Hold" in the Fly View tools.
 
Return:		  Flight mode when Return has been commanded, and the Vector is either enroute to the landing location or 	
		  in the process of landing.
 
Land:		  Flight mode when EMERGENCY LANDING has been commanded. 

Position:		 Operator intervention enabled. Vehicle maintains altitude and course.
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Auterion Mission Control interface

The AMC has two main views: Fly and Plan. Fly View is used for controlling the vehicle in flight, viewing the full motion video 
stream, recording videos, designating orbit points and points of interest and using the Approach feature for Vector landing.

Plan View is used for detailed mission planning in cases where Fly View features don’t provide enough control over the 
mission parameters – for example, when the launch and landing site is extremely restrictive, or for long-range missions in 
variable terrain where detailed mission planning tools are required to ensure safe altitudes during all phases of the flight.

To switch between Fly View and Plan View, select          .  

Flight Operation
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Flight Operation

Vertical speed

Altitude Above Ground Level or 
Altitude above Mean Sea Level 
(Tap telemetry window to 
change between AGL/MSL)

Horizontal/
ground speed

Indicated 
airspeed

Distance from Launch

Wind speed 
and direction

Time in flight

Compass rose
incl.:	 - wind direction (blue arrow)
	 - field of view 
	 - direction towards the home 	
	   position (orange dot)

Telemetry window in Fly View

Height above takeoff
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Flight Operation

7

Toggle Video Recording

UAV and camera can manually be controlled via the joystick. Furthermore, the tablet offers quick access to selected camera 
functions. The default button assignment is shown in the graphic below:

Trigger Camera

Return to Land

Gimbal Pitch Gimbal Yaw

Return to Land

Left Joystick

Left: Gimbal Angle Mode
Up: Gimbal Rate Mode
Right: Gimbal Scene Mode
In: Gimbal Center

Step Zoom In

Right Joystick

Step Zoom Out

Skynav Tablet
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In Menu > Vehicle Settings > Joystick > Calibration it is possible to recalibrate the joysticks and dials in the event that they 
become uncalibrated, either by another user or as the result of a drop or impact. 
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Skynav button assignment

Skynav’s physical inputs include two joysticks, two dials, six main buttons, a 5-directional pad and a stylus for increased preci-
sion when using the touch-screen. The buttons and dials are used solely to control payload (camera) functions. The joysticks 
are used, in certain flight modes, to control the altitude, yaw, pitch, and roll of the Vector. Other commands such as Takeoff 
and Return, for example, are issued via the touch-screen user interface in Auterion Mission Control in a two-step process. This 
guarantees that such commands are issued deliberately, not as the result of an accidental press of a physical button. 

Within Auterion Mission Control (AMC), it is possible for the operator to customize button assignments in 
Menu > Vehicle Settings > Joystick > Button Assignment. 

However, using the default button assignments is recommended. Note that a Vehicle must be connected in order to access 
Vehicle Settings.

Default buttons assignment:

0:	 Return to Land
1:	 Toggle Recording Video
2:	 Return to Land
3:	 Gimbal Rate Mode
4:	 Gimbal Angle Mode
5:	 Gimbal Scene Mode
6:	 Gimbal Center
7:	 No Action
8:	 No Action
9:	 Step Zoom In
10:	 Step Zoom Out
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Left Stick Up 
Once the Vector transitions from forward fixed-wing flight to VTOL Hover mode and begins 
descending to land, the operator can slow the Vector’s rate of descent by pushing upward on 
the left stick. 

However, if any of Vector’s internal components are near their thermal limits, the operator will lose the 
ability to slow the Vector’s rate of descent. 

Vector controls during landing

Scorpion: manual commands 

translate right

backwards

forward

translate left

climb

turn right

descend

turn left

Left Joystick Right Joystick
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Left Stick Right and Left
As the Vector is descending to land in VTOL 
mode, the operator can also move the left stick 
left and right to rotate the Vector as needed to 
best position it for landing. 

However, the Vector will automatically align itself 
into the wind using its onboard sensors, so this 
is not recommended if there is no need to avoid 
obstacles on the ground. Avoid making drastic 
inputs during landing. 

Right Stick 
Moving the right stick during landing will cause 
the Vector to translate forward, backward, left and 
right. 

Avoid making drastic inputs during landing.
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Pulling down on the right 
joystick will make the Vector 
climb and releasing it will 
make the Vector stop climbing. 
Pushing forward on the right 
joystick will cause the Vector to 
descend and releasing it will 
cause the Vector to stop 
descending. 

Once the right 
joystick is released, the Vector 
will maintain its present 
altitude. 

Pushing left and right on the 
right joystick will make the 
Vector turn left and right. 

Releasing the joystick will cause 
the vector to stop turning and 
continue flying on its current 
course. 

Vector controls in Position Mode in forward cruise flight (VTOL: Fixed-wing configuration)

When the Vector is flying in Position Mode, the user has manual control over the Vector’s flight path. 

In other words, the Vector is not autonomously navigating to a waypoint or mission item, but the system is still using its 
onboard sensors to hold altitude and course. When flying in Position Mode, the left stick is not used. 

All direct control inputs are entered using the right joystick. 

NOTE: You have to switch to Position Mode in AMC. A stick input does not automatically activate Position Mode to avoid 
             unintentional inputs.



57

7

Flight Operation

Controls and Emergency Actions during takeoff

While the Vector is in the process of taking off and transitioning to forward flight, the operator has no direct control over the 
Vector via joystick inputs. However, two emergency actions are available. 

Note: These Emergency Actions are available during all phases of flight in both Vector & Scorpion configuration.

CAUTION:	 Executing these emergency actions should be done only in true emergency situations and 	
		  may result in destruction of the air vehicle.
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EMERGENCY LANDING: 
Vector in VTOL-Mode & Scorpion: Vehicle will descend straight down from its present location and attempt to land. 
Vector in forward cruise flight: Vector will transition to VTOL mode and attempt to land immediately after transitioning. 

Note: If the Vector is more than 164 feet (50 meters) above the ground, there is a risk that the Vector’s internal components 
will overheat, and the motors might fail to work. Avoid executing Emergency Landings if at all possible, and especially when at 
altitudes exceeding 164 feet (50 meters) and when the ambient temperature is high. 

EMERGENCY SHUTDOWN: Executing an EMERGENCY SHUTDOWN will cause the Vehicle’s motors to stop. 

EMERGENCY SHUTDOWN:		  Executing an EMERGENCY SHUTDOWN in flight will cause the 	
					     Vehicle to crash and be destroyed.

Offline Maps & Custom Elevation Model

Imagery and elevation tiles can be downloaded via Settings > Offline Maps > Add New Set.
Make sure to select a map and elevation provider.  
Note: The respective map and elevation providers have to be selected in Settings > General

Custom elevation data can be imported in Settings > Offline Maps.
Make sure to check plausibility before taking off.

Note: Using 3D-Map view offline requires the following procedure:
	 1. Make sure the tablet is connected to the interned during preperation
	 2. Move the map to the area in which you intend to fly. 
	 3. Activate 3D-View by clicking on the icon in the lower left corner
The 3D-Map data will be downloaded and stored automatically in the local cache.  
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GeoTiff processing pipeline

This tool provides a toolchain for converting elevation and imagery data stored in GeoTiff files to Slippy Map tiles. These 
custom imagery and elevation tiles can then be imported into AMC

Supported input:
-Single GeoTIFF files
-Folder containing multiple GeoTIFF files. In this case the tiles are generated from the combined dataset.
-Imagery or elevation dataset.

Supported projections:
All projections that are contained within the PROJ 7.2.1 database.
To test if given projection is supported run gdalsrsinfo -V EPSG:<your code> (complete installation required, see below)

Output:
Projection: WGS84 EGM96
Format: Slippy map format ./zoom/x/y.png
Resolution: 256x256
For elevation input data:
	 - RGB encoded.
	 - Elevation is given by: elevation = -10000 + ((R * 256**2 + G * 256 + B) * 0.1).
	 - No data value: R=0, G=0, B=0 i.e. elevation = -10000.
	 - For high resolution datasets additional lower resolution zoom levels are generated.
For imagery input data:
	 - Zoom levels ranging from 0 to native zoom level.
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GeoTiff processing workflow

Ubuntu

Requirements:	 Ubuntu 20.04 (recommended)

To install the dependencies:	 Run ./setup.sh

To generate tiles from a single tif file or a folder containing multiple tif files:	 Run ./process.sh <inpath> <outpath>.

Windows 10

Requirements:	 Windows 10 version 20.04 (OS Build 19041.264) or higher.

To setup WSL and install the dependencies:	1. Run setup.bat as administrator. This will enable the required Windows features 	
					          for WSL. 
					     2. Restart your computer.
					     3. Run setup.bat as administrator. This will download the WSL kernel and launch 	
					          the installer.
					     4. Follow the instructions of the installer.
					     5. Install Ubuntu 20.04 LTS from the Microsfot Store.
					     6. Launch Ubuntu 20.04 LTS.
					     7. Create a new UNIX user.
					     8. Continue running setup.bat (or re-run if closed). This step may take a while to 
					          finish.

To generate tiles from a tif file or folder containing multiple tif files:	 1. Open a power shell (winkey + x then Windows 
								        PowerShell)
								        2. Run ./process.bat <inpath> to generate the tiles.
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Fly View

1.	 Open the menu by clicking on the AMC-Logo in the top left corner         .
2.	 Select “Fly View”. 
3.	 Click on       .
4.	 Specify those areas that are safe to be used for approach and landing.

Green areas: No obstacles or terrain greater than 30 feet below the Vector’s backtransition height.
Red areas: Not usable due to obstacles in that sector.

Ideal situation: All sectors green Possible scenario if the wind direction can be de-
termined precisely. Alwas land with headwind!

NOTE: 
The Vector will select the best of the available (green) sectors depending on the wind situation.

7

Flight Operation
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5.	 Confirm your selection by clicking and holding 
6.	 As soon as the approach-pattern is confirmed, the Takeoff will be adjustable.
7.	 By dragging and dropping the white dot, the takeoff direction and distance can be adjusted

	 a.	 +/- 45° right and left of the current heading.
	 b.	 The distance between takeoff location and center of the Orbit can be adjusted from 160m to 320m.
	 c.	 The transition altitude (altitude above takeoff in which the vector switches from hover-mode to forward 	
		  flight can be adjusted with the slider on the right from 10m to 25m. 
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9.	 Takeoff is initiated by confirming the changes 
	 The Vector will climb to 100m above takeoff and orbit there.
10.	 Once the Vector has transitioned to forward, cruise flight and begun orbiting in the safe sector, the user can 
 	 then start issuing other commands (e.g. Orbit, Altitude, Start Mission, etc.)
11.	 If the Approach Area needs to be changed for landing after taking off, click on "Approach" on the left side of the
 	 screen in Fly View (with map primary). Change the Approach Area as required and upload it to the Vector by
	 selecting "Hold to confirm". Note that at least one sector always needs to be green.
12.	 Select "Return". The Vector will:
	 • Climb to the Return To Launch Height.
	 • Based on the wind estimate, select the most favorable area, then fly there automatically.
	 • Once in the Approach Area, descend in a tight orbit until reaching the Approach Backtransition Height.
	 • Once reaching the Backtransition Height, fly to the landing point, transition to VTOL hover, and descend to 	
	 land.
	 • While the Vector is descending to land, the user can use stick inputs to control the rate of descent of the Vector 	
	 (left stick up and down), the yaw or rotation of the Vector (left stick to the right and left), and the position of the 	
	 Vector (right stick to the right and left).
	 • Once the Vector lands, the motors will automatically turn off and the system will disarm.

Fly View takeoff can be used with the Scorpion as well. 

1. 	 Select "Takeoff" in Fly View
2.	 Adjust the altitude the Scorpion is initially supposed to climb to.
3.	 Confirm your selection by clicking and holding the takeoff-button.
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• 	 Wind must not exceed 23 knots (12 meters per second).
• 	 No obstacles or terrain greater than 30 feet below the Vector’s backtransition height anywhere within that sector.
•  	 Mark as many sectors safe as possible so the system has the best chance to take off and land into the wind. If at all 		
	 possible, the Vector should be physically facing into the wind, and the sectors immediately in front of and behind the 	
	 Vector should be safe. This ensures that the Vector is able to both take off and land facing into the wind, since there is 	
	 an available safe area in each direction.
• 	 In calm winds, when there is no other option, at least a single sector must be marked safe. 

Approach Feature criteria 
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Fly View takeoff: Best practice 

1.	 Orient the Vector towards headwind. 

2.	 Select Approach. At least those sector(s) for headwind-landings should be marked green. Go through all 8 sectors, 	
	 and mark green all that are safe (no obstacles or terrain greater than 30 feet below the Vector’s backtransition height).

3.	 Go to   > Vehicle Settings > Safety and set the Safe Area Backtransition Height above all terrain and obstacles 	
	 in the safe sectors. This is the altitude to which the Vector will orbit and descend to land within a safe sector. Then, 		
	 Vector will approach the landing point at this same altitude, transition to VTOL, and descend vertically to land.

4.	 Also in   > Vehicle Settings > Safety, set the Return to Launch Height to an altitude greater than the elevation of 	
	 all terrain and obstacles in the mission area. Remember that RTL Height is defined as altitude above the launch loca-	
	 tion. 

7

Flight Operation
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Fly View tools when map is primary

Fly View provides some useful tools for controlling the Vehicle while in flight. The set of available tools changes based on 
whether the map or video is primary. When the map is primary, the following tools are available

Return
Commands the Vehicle to return to the launch location and then land using the Approach-Feature. To land with the preplanned 
mission landing, the descent-circle waypoint has to be selected first. Then continue the mission. 

Land (Scorpion only)  
Commands the Scorpion to land at the current vehicle location. Make sure the surface below the vehicle is landable. 

Hold  
Pauses the mission plan that the vehicle is executing, or pauses whatever its current action is, and places the Vector into a tight 
orbit at its present location. The Scorpion will hover at the current location.

Mission 
If the mission plan has been paused in order to perform some other action (for example, flying in Position mode or commanding 
Orbit with the Actions tool), selecting Mission will allow the user to continue on with the planned mission.

Altitude 
Changes the altitude of the vehicle. Note: this altitude is set relative to the launch location’s elevation, not above terrain with 
respect to the Vehicle’s current location

Actions
Contains two smart actions: Orbit, GoTo (Scorpion only) and Point of Interest (POI).

Approach (Vector only)
Allows the user to modify the 8-Sector Safe Area for descent and landing.

Marker
Set markers for increased situational awareness. See page 66 for details.
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Smart Actions

The Point of Interest (POI) and Orbit Smart Actions are quick, intuitive tools for controlling the Vehicle and its camera.

The POI allows the user to point the camera at a position specified on the map. Simply click POI, and then select a location on 
the map. The gimbal will attempt to look at that location. Note that specifying a POI does not alter the flight path of the Vector. 
It is simply a means of pointing the camera; the Vector will not deviate from its present course or maneuver itself to put the 
POI in the camera’s field of view. To remove the Point of Interest, select the reticle symbol at the top of page       . 

Orbit allows the user to set up a quick Orbit point with a selectable altitude and radius. Select Orbit, then designate a point on 
the map. Slide the orbit path to the desired radius, then set the desired altitude for the orbit with the slider on the right. Check 
the POI slider within the Orbit menu to also specify a POI at the orbit location (the camera will look at the center of the orbit).
In Scorpion configuration, the orbit-speed can be adjusted with right/left inputs on the right joystick.

Goto (Scorpion only) allows the user to send the vehicle to a fixed location. Set Goto, then designate a point on the map. 
Select the desired altitude with the slider on the right. The Scorpion will stay in a stationary hover once the coordinate is rea-
ched.

Orbiting will “pause” the current mission, if executing a preplanned mission created in Plan View. To continue the planned 
mission, select Mission from the Fly View tools, then hold to confirm. To continue the mission at a specific waypoint, select and 
confirm the desired waypoint first before continuing the mission.

CAUTION: Remember that these altitudes are relative to the launch location, so carefully consider the 
                    difference in ground elevation between where Vector was launched and where the orbit 
                    point is located.

Vector Scorpion
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Marker

To incrase situational awareness, markers can be placed on fixed coordinates in the map. These markers are then displayed in 
Camera-View aswell. 

To set a marker 
	 a. Go to Fly-View > Marker in the tool-window on the left of the screen- 
	 b. Select the desired marker-type
	 c. Click on the targeted location on the map to place the marker

Each marker-type can be used multiple times (e.g. to identify multiple opjects of the same category)

To delete the marker
	 a. Click on the marker in the map to select
	 b. Select "del. Selected" in the marker-tool window on the left of the screen.
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Fly View Map Options

    
The Map Options are located on the lower left corner in Fly-
View  

Switch to 3D-View. This might be helpful for flight operations in uneven terrain. Go back to 2D-View by 
clicking on the map-button in the lower left corner.

Opens Measurement-Tools 
Click inside the map to select measurement points. Se-
lect points to  adjust, add or delete points. There is also 
the option to enter coordinates manually

Delete previous flightpath to declutter the map

Change between maps 

Import kml-files to your map
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Fly View map and video switching

When in Fly View, the user can switch between two layouts

•	 Map primary, video secondary
•	 Video primary, map secondary

To switch between these layouts, tap on the secondary display in the bottom left corner of the screen. 
The size of the secondary view box can be adjusted by clicking and dragging the box’s upper right corner.

Map primary, video secondary. Video primary, map secondary.
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Center Aircraft in map

Double click to lock/unlock aircraft permanently in map center Adjust the size of the window      

Detach the window from the 
lower left corner     

Minimize the lower left corner

Flight Operation
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1.    AMC Menu / Fly, Plan, Vehicle Setup, 
       Photos, User Account, Settings
2.    Vehicle Selector/Status
3.    Flight Mode
4.    Camera Center Field of View and Slant   
       Range  (select to change to MGRS)
5.    Emergency Actions/Arm Status
6.    Connection Manager
7.    Point of Interest Defined/Undefined
8.    Vehicle GPS Status
9.    Radio Signal Strength

10.    Estimated Flight Time Remaining
11.    LTE Status
12.    Vehicle Battery State of Charge
13.    Tablet Battery State of Charge
14.    Notification Log
15.    Telemetry/Situational Awareness
16.    Video, plus map center and Vector coordinates
17.    Fly-View Map Options
18.    Fly View Tools
19.    Mission Items/SmartActions (Waypoints, Orbits, etc.)
          Vehicle Location (blue chevron) and Vehicle Track (red trail)

32
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Fly View video primary, map secondary

When video is primary, camera control and information fields appear on the right side of the screen.
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Camera settings and media 
storage information

Displays the current gimbal mode 
(Track, Scene, Angle, Rate)

Gimbal pitch angle and orientation 
relative to the vehicle (green field 
of view symbol)

Camera zoom (zoom in and out 
also bound to Skynav controller 
buttons

Select between the 
electro-optical camera (left), 
and the long-wave infrared 

thermal camera (right)

Start/Stop 
Video Recording
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Gimbal control

Gimbal Pitch Dial 
To look upward, slide the Gimbal Pitch Dial to the right. To look downward, slide the gimbal pitch dial to the left.

Gimbal Yaw Dial
To look left and right, move the Gimbal Yaw Dial left and right.

Gimbal Center (5-D Pad inward) 
Re-centers the gimbal to look straight ahead in front of the Vehicle, and puts the gimbal in Angle Mode.

Gimbal Scene Mode (5-D Pad right) 
The system will attempt to keep the camera pointing at whatever objects are currently in view using a tracking algorithm. 
Generally, this is the most useful mode for observing objects on the ground while orbiting. Scene Mode is the gimbal mode 
recommended for use in most cases.

Gimbal Angle Mode (5-D Pad left) 
The gimbal’s orientation will be fixed in place relative to the Vehicle. This is useful for manually flying the Vehicle in Position 
Mode, because it provides a consistent first person view from the air vehicle.  

Gimbal Rate Mode (5-D Pad up) 
The gimbal’s orientation is fixed relative to the earth’s position. This mode may be useful for searching for objects on the 
ground, or when it is difficult to keep an object in view in Scene Mode. Try using Scene Mode first, and if that proves difficult, 
consider using Rate Mode. 
 

Flight Operation
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Object tracking

When video is primary in Fly View, the Track feature becomes available. Pressing Track and then selecting an object on the 
ground in the video display will command the gimbal to track that object. To stop tracking an object, select Track again. This 
feature works best when there is good foreground-background contrast. 

1.	 Go to Plan View and ensure no mission waypoint symbols are shown on the map. To clear all mission waypoints from 	
	 both AMC and the Vehicle, select File > Clear.

Detailed launch and takeoff mission planning in Plan View

Some launch and recovery sites are so restrictive and full of obstacles that using the Safe Area feature in Fly View is not a 
viable option. In such cases, use Plan View to conduct full mission planning.
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2.	 Select Takeoff to specify the Launch location      . Designate the location on the map from which the Vehicle will take 	
	 off. If the Vehicle is connected, this defaults to the Vehicle’s location.

3.	 Adjust the       icon on the map. This sets the transition direction. Vector will transition from VTOL to 
	 cruise flight in this direction then move on to the next mission item. Transition direction should be into the wind 		
	 (Vector should also be facing into the wind). Click on "Done Adjusting" if launch location and transition direction are 	
	 set.
	

L

T
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5.	 Plan mission items, as needed (e.g. set an Orbit Point)
		  a. Select Waypoint on the left side of the screen and designate a place on the map.
		  b. In the drop-down menu, select Orbit (time)
		  c. Set the altitude for the Orbit point
		  d.  Note that this altitude is altitude above the launch elevation.
		  e. Set the time for which the Vector should remain at the Orbit point before proceeding to the next mission 	
		  item.

4.	 Set VTOL Takeoff altitude. This value is limited to between 33 ft and 92 ft. 
	 Select an altitude at least 30 ft greater than the height of any obstacles between       and       . L T

VTOL-Takeoff:
Altitude: Height in which the Vector changes from Hover-Mode to forward flight
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8.	 Select Upload Required.

9.	 Double check all mission altitudes. 
	 Note that if terrain data is available, AMC will check the flight path between waypoints for terrain collisions. 
	 However, this functionality is limited and can’t prevent terrain collisions in all scenarios. 
	 Users should closely monitor the Vector at all times during flight.

10.	Go to Fly View, make the map primary, and ensure mission items appear in their proper locations on the map 
	 (note that the simulated Vector trajectory line will not appear; this is expected). This verifies that the mission 
	 has successfully uploaded. 

Note: Transition settings are omitted in Scorpion mission planning.
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Plan View

When the Actions functions in Fly View (Orbit and Point of Interest) are not sufficient, additional mission items are available in 
Plan View. 

Planning takeoffs and landings in Plan View has already been covered in the previous section. This section will cover additio-
nal details about mission items available in Plan View.

Plan View mission items

In Plan View > Waypoints, there are three options for mission items:

Waypoint:	 Suitable to create a flightpath

Orbit (time): 	 Suitable to stay at a fixed area to survey

Orbit (altitude): 	 Suitable to reach a certain altitude before the flight 		
		  path continues. Necessary to avoid terrain collision if 	
		  the Vector is not able to reach the required 
		  climb/descent rate directly on route.

Note: The Orbit (altitude) option is not available for Scorpion.
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Waypoint

The vehicle will fly to the user-specified location and altitude, and once there, continue on to the next mission item, whether 
that is another Waypoint, Orbit (time), Orbit (altitude), or the landing pattern specified during mission planning. If there is no 
mission item after the Waypoint, the vehicle will orbit in place at the Waypoint’s location. The vehicle will orbit at the waypoint 
location until the targeted altitude is reached.
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Orbit (time)

The vehicle will fly to the user-specified Orbit (time) location and altitude. Once there, the vehicle will orbit until the Orbit Time 
expires, at which point it will continue on to the next mission item. 
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Waypoint and Orbit (time) altitude behavior

Note: All mission item altitudes are relative to the launch elevation, not relative to the terrain at the mission item’s location.

If an Orbit (time) or Waypoint mission item’s altitude is higher or lower than the vehicle’s current altitude, the vehicle will fly on 
a straight line to the destination mission item. For example, vehicle will not climb immediately to the destination mission item’s 
altitude and then fly level. 

If the vehicle’s climb or descent rate is not sufficient to reach the destination mission item on a straight line path, the Vector will 
orbit at the mission item’s horizontal location to finish the climb or descent to the item’s altitude.

Altitude

Distance

Altitude

Distance

Altitude

Distance
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Orbit (altitude) behavior (Vector only)

Recall that Vector will fly to the Orbit (altitude) point at its current mission altitude. Only once it reaches the Orbit (altitude) 
horizontal location will the Vector begin climbing or descending to the user-specified altitude. This is unlike the behavior of 
the other mission items described above. When using Orbit (altitude), be especially cautious about terrain collisions.

Distance

Altitude

Orbit (altitude) is suitable to reach a certain altitude before the flight path continues. Necessary to avoid terrain collission if 		
the Vector is not able to reach the required climb/descent rate directly on route.
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Flight Operation

1.	 Specify the landing by clicking on the button on the left side of the screen. 
2.	 Select the landing spot on the screen or set the landing spot to vehicle position with the button in the mission element on 	
	 the right. The whole landing pattern will appear. 
3. 	 Adjust direction and approach path as required for headwind landing. Make sure the approach path is clear of obstacles.
4.	 Select “Done” in the mission element to proceed with the settings.

Orbit point: 

Altitude: Height above takeoff in which the aircraft will change from forward flight to 
                 hover-mode.
Radius: Radius of the descent circle. The aircraft will descent in forward flight mode 		
               from mission altitude to the altitude specified in the “Altitude” setting above. 
Orbit clockwise: The circle direction can be changed for the descent circle. This does not affect 	
	                other orbit waypoints.

Landing point: 

Heading: Heading in which the aircraft will straighten out coming from the descent circle. It will 	
	   change to hover mode in the direction specified here.
Altitude: Offset relative to the takeoff altitude. The aircraft will validate the setting with its build- 	
	   in ground distance sensor.
Landing distance: Distance from the orbit location to the landing spot.
 

Plan View landing
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Switching between Fly View and Plan View 

It is possible to use Plan View mission items during flight, even after taking off using the Safe Area feature in Fly View. The re-
commended workflow for doing this is to take off in Fly View, then once flying in the automated orbit in the Safe Area, go to 
Plan Mode and add mission items as needed. It is not necessary to specify a landing approach pattern in Plan View if you also 
wish to land using the Approach feature. You can simply add Waypoint, Orbit (time), and Orbit (altitude) mission items. Once 
you’ve added the desired mission items, upload them to the vehicle. 

Switch to Fly View, select on the map the mission item to which you want to navigate and hold Set Waypoint. 
The selected mission item will become the active mission item (the active mission item is highlighted in green, while the ohers 
are orange). Select Mission, and then hold Continue Mission. The vehicle will navigate to the active mission item. You can go 
back to Plan View and modify the mission as many times as needed during the course of the flight using the same 
workflow.

It is also possible to land using Plan View mission planning, even if you took off using Fly View. There is nothing different about 
that process. Upload the landing pattern/descent orbit and landing point to the vehicle once complete. 

When it comes time to land, the Vector will use the Approach-Segments by default when Return is selected. To make the Vec-
tor land using the uploaded Plan View mission items, go to Fly View and set the landing pattern/descent orbit as the active 
mission item by selecting it on the map and holding Set Waypoint. Selecting Mission and holding Continue Mission will cause 
the Vector to enter the planned landing pattern/descent orbit, and then land at the landing point. 
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Flight Operation

Open the Altitude-Plot by clicking on           in the lower left corner of the screen.

You can choose from three options:

MSL: 	 Heights are displayed referenced to the Mean Sea Level. 
AGL: 	 Heights are displayed referenced to the ground below the vehicle (Above Ground Level). Please note that a valid 
	 elevation model is required.
ATO: 	 Heights are displayed referenced to the takeoff location (Above Takeoff).

Altitude-Plot
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Terrain Altitude 

When using Plan View, the Terrain Altitude feature provides some basic functionality for avoiding terrain collisions. This feature 
checks for terrain collisions between mission items by using their user-specified locations and altitudes, as well as elevation 
data for the mission area. This is why it is important to have either internet connectivity or to download offline maps in AMC. 

Remember that the Terrain Altitude feature is only available when using Plan View to specify mission items. Consider the 
following scenario: An operator is flying the Vector in Fly View, selects Action, and designates an orbit location 12 kilometers 
away. Auterion Mission Control does not conduct a Terrain Altitude check in this case. Now suppose that instead, the operator 
goes to Plan View, and specifies an Orbit (time) at the same location, then goes back to Fly View, and continues the mission to 
that Orbit. In this case, AMC does conduct the Terrain Altitude check. Therefore, it is advisable to use Plan View to plan distant 
flight paths across varying terrain.
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If the Auterion Mission Control’s Terrain Altitude feature projects a collision 
enroute to the waypoint, the flight path leg is shown in red and 
Altitude-Plot shows a red area beneath the waypoint. A mission with colli-
sion projected cannot be uploaded from AMC to the Vehicle. 

Once the user selects the respective waypoint and raises its altitude suffi-
ciently, the flight path leg will go back to green (normal), and the mission 
can then be uploaded to the Vehicle and flown.

How the Terrain Altitude feature functions in the AMC User Interface

CAUTION: Remember that this altitude is relative 
to the launch location, so carefully consider the 
difference in ground elevation between where 
Vector was launched and where the orbit point is 
located.

7

Flight Operation
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Scorpion Pre- Checklist

1.	 Assemble Skynav, Silvus ground radio, and Scorpion.

2.	 Power on Scorpion.
	 a.	 Press the SoC/Heat button
	 b.	 Insert the Smart Battery with arrow facing forward.
	 c.	 Replace battery cover and secure both latches.

3.	 Power on Silvus ground radio and set radio profile dial to 1.

4.	 Power on Skynav and open AMC.  

5.	 Select desired vehicle from the connection manager or pair a new vehicle.

6.	 Select the desired operating frequency in the connection manager.
       If using Fly view proceed to step 7, if using Plan view proceed to step 1

7.	 Select Fly.

8.	 Select Menu > Vehicle Setup > Safety.

9.	 Set the Return to Launch Height to an altitude greater than the elevation of all terrain and obstacles in the mission
       area. Remember that RTL Height is defined in terms of altitude above the launch location.

10.	Complete the assisted preflight checklist.

11.	Place Scorpion into the wind at the launch location.

12.	Ensure Scorpion heading on map (blue chevron) matches actual heading.
	 a.	 If it does not, then rotate the Scorpion 360 degrees horizontally and re-check.



91

7

Flight Operation

13.	Ensure good video in Fly View.

14.	Ensure there are no overhead or ground obstacles.

15.	Ensure there are no personnel within 10 meters of Scorpion.	

16.	Select Takeoff and adjust Takeoff altitude above terrain and obstacles as necessary.

17.	Hold to confirm Takeoff. 
	
18.	Select Plan and verify all mission item symbols are cleared. 
	 a.	 If not, select File > Clear.

19.	Place Scorpion into the wind at the launch location.

20.  Ensure Scorpion heading on map (blue chevron) matches actual heading.
	 a.	 If it does not, then rotate the Scorpion 360 degrees horizontally and re-check.

21. Open a previously saved mission, or plan a new mission. To plan a new mission:
	 a.	 Select Takeoff and specify the Launch location. If the Scorpion is connected, this 
                       defaults to the Scorpion’s location.
	 b.	 Specify VTOL Takeoff Altitude.
                       i.    Choose an altitude greater than the height of any obstacles).
	 c.	 Add and adjust mission items as necessary by selecting Waypoint and then designating a point on the map.
	 d.	 Select Land.
	 e.	 Select set to vehicle location or designate a point on the map and select Done.

22.  Select Upload Required.

Note:  If terrain data is available, AMC will check the flight path between waypoints for terrain collisions. However, this 
functionality is limited and can’t prevent terrain collisions in all scenarios. Users should closely always monitor the 
Scorpion during flight.
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23.	Select Fly View, make the map primary, and ensure mission items appear in their proper locations on the map.

24.	Select Menu > Vehicle Setup > Safety.

25.	Set the Return to Launch Height to an altitude greater than the elevation of all terrain and obstacles in the mission
       area. Remember that RTL Height is defined in terms of altitude above the launch location.

26.	Complete the assisted preflight checklist

27.	Ensure good video in Fly View.
	
28.	Ensure there are no overhead or ground obstacles.

29.	Ensure there are no personnel within 10 meters of Scorpion.

30.	Select Mission icon.

31.	Hold to confirm Start Mission to take off.

Vector Pre- Checklist

1.	 Assemble Skynav, Silvus ground radio, and Vector.

2.	 Power on Vector.
	 a.	 Press the SoC/Heat button
	 b.	 Insert the Smart Battery with arrow facing forward.
	 c.	 Replace battery cover and secure both latches.

3.	 Power on Silvus ground radio and set radio profile dial to 1.
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4.	 Power on Skynav and open AMC.

5.	 Select desired vehicle from the connection manager or pair a new vehicle.

6.	 Select the desired operating frequency in the connection manager.	
       If using Fly view proceed to step 7, if using Plan view proceed to step 22

7.	 Select Fly.
	
8.	 Select the Approach icon. 

9.	 Specify areas that are safe to be used for approach and landing (green is safe, red is unsafe).

Note:  The Vector will automatically select the best of the green safe sectors depending on wind conditions.

10. 	Confirm safe sector selection using Hold to Confirm popup.
	
11. 	Select Menu > Vehicle Setup > Safety.

12. 	Set the Return to Launch Height to an altitude greater than the elevation of all terrain and obstacles in the mission
       area. Remember that RTL Height is defined in terms of altitude above the launch location.

13. 	Set Safe Area Backtransition Height to an altitude greater than all obstacles in selected safe approach sectors. 
       Remember Backtransition Height is defined in terms of altitude above launch location.

14. Complete the assisted preflight checklist.

15. Place Vector into the wind at the launch location.

16. Ensure Vector heading on map (blue chevron) matches actual heading.
	 a.	 If it does not, then rotate the Vector 360 degrees horizontally and re-check.

Flight Operation

7
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17.	Ensure good video in Fly View.

18.	Ensure there are no overhead or ground obstacles.

19.	Ensure there are no personnel within 10 meters of Vector.

20.	Select Takeoff and adjust Takeoff Orbit location and Transition Height as necessary
	 a.	 Takeoff direction must be within +/- 45° right and left of the Vector’s heading.
	 b.	 The distance between Takeoff location and center of the Takeoff Orbit can be adjusted from 160m to 320m
                        by holding and dragging.	
	 c.	 The Transition Height (altitude above takeoff at which the Vector transitions from VTOL to forward flight) 
                       can be adjusted with the slider from 33 feet to 82 feet (10 m to 25 m).
	 d.	 Vector will climb to an altitude of 329 feet (100 m) and hold at the takeoff orbit location.

21.	Hold to confirm VTOL Takeoff.
	
22.	Select Plan and verify all mission item symbols are cleared
	 a.	 If not, select File > Clear.

23.	Place Vector into the wind at the launch location.

24.	Ensure Vector heading on map (blue chevron) matches actual heading.
	 a.	 If it does not, then rotate the Vector 360 degrees horizontally and re-check.

25.	Open a previously saved mission, or plan a new mission. To plan a new mission:
	 a.	 Select Takeoff and specify the Launch location. If the Vector is connected, this defaults to the Vector’s 
                       location.
	 b.	 Adjust the transition direction icon on the map into the wind and select Done Adjusting.	
	 c.	 Specify VTOL Takeoff Altitude.	
                       i.    Choose an altitude greater than the height of any obstacles in line with L and T.
	 d.	 Add and adjust mission items as necessary by selecting Waypoint and then designating a point on the map.
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	 e.	 Select Land.	
	 f.	 Select set to vehicle location or designate a point on the map.	
	 g.	 Adjust landing pattern orbit point so approach is into the wind and select Done
	 h.	 Adjust landing pattern orbit point altitude to the desired Backtransition Height.

26.	Select Upload Required.

Note:  If terrain data is available, AMC will check the flight path between waypoints for terrain collisions. However, this 
functionality is limited and can’t prevent terrain collisions in all scenarios. Users should closely always monitor the Vector 
during flight.

27.	Select Fly View, make the map primary, and ensure mission items appear in their proper locations on the
       map. 

28.	Select Menu > Vehicle Setup > Safety. 

29.	Set the Return to Launch Height to an altitude greater than the elevation of all terrain and obstacles in the 
       mission area. Remember that RTL Height is defined in terms of altitude above the launch location.

30.	Set Safe Area Backtransition Height to an altitude greater than all obstacles in selected safe approach sectors. 
       Remember Backtransition Height is defined in terms of altitude above launch location.

31.	Complete the assisted preflight checklist.

32.	Ensure good video in Fly View.

33.	Ensure there are no overhead or ground obstacles.

34.	Ensure there are no personnel within 10 meters of Vector.

35.	Select Mission icon. Hold to confirm Start Mission to take off.

Flight Operation

7
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8. ATAK-SETUP
    (ANDROID TEAM AWARENESS KIT)

8

ATAK-Setup
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General information

Knowing the exact location of a teammate, a vehicle, or a point of interest may be crucial for the coordination of operations. 
Mission Control is capable of sharing the location of the vehicle, the ground station, current points of interest as well as manu-
ally marked locations with other team members using the Android Team Awareness Kit (ATAK).

Required Hardware:
•	 Skynav Tablet
•	 Silvus Data-Link
•	 Ethernet Switch
•	 Android device with ATAK installed (Application is available in the Google PlayStore)

Connection Procedure:

1.	 Connect the Silvus Ground radio to the ethernet switch.

2.	 Connect the tablet/phone running ATAK to the ethernet switch

3.	 Connect to the ethernet switch to the Skynav

4.	 Power the ethernet switch
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AMC settings 

1.	 Select  > Settings > General.

2.	 Scroll down to Team Awareness (Smartphone Integration) section.

3.	 Turn on “Enable Team Awareness” and “Enable on startup”.  In Fly View, the Team 
	 icon will be highlighted in blue, indicating that ATAK functionality is enabled.

4.	 Set "Controller Callsign" to "Mission Control".

5.	 Set Destination Address to 172.20.255.255.

6.	 Set Destination Port to 4242.

7.	 Set Destination Protocol to UDP.

8.	 Set Incoming Port to 8089.

9.	 Set Incoming Protocol to UDP.

8
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AMC settings 

1.	 Click on the three dots on the top right. A menu will open. 

2.	 Choose Settings > Network Connections. Click on "Network Connections" in the pop-up window.

3.	 Go to the Input/Output Management section and click on "Manage Inputs". 

4.	 Edit the default connection (click on the pencil icon) and set address to 0.0.0.0.

5.	 Tick the advanced options
		  a.	 Select Input Protocol to UDP.
		  b	 Set Server Port to 4242.
		  c.	 Confirm changes

6.	 The checkbox next to the default entry must be checked.

7.	 Go back to Input/Output Management. Click on "Manage Outputs".

8.	 Click on the three dots in the top right and select "Add". 
		  a.	 Set name to "AMC".
		  b.	 Set address to 172.20.1.1 

9.	 Tick the advanced options
		  a.	 Select Input Protocol to UDP.
		  b	 Set Server Port to 8089.
		  c.	 Confirm changes

10.	The checkbox next to the AMC entry must be checked.
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Video settings

1.	 Click on the video symbol in the top toolbar. Click on the "+" in the menu. 

2.	 Change type to "rtsp" in the popup-window.

3.	 Add 172.20.110.10:8553/stream1

4.	 Optionally: Stream can be named (e.g. "Vector 00012")

5.	 Click on "Add". The stream will appear in the left menu.

8
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Offline maps for ATAK 

1.	 Open an internet browser and download the following two files:
		  a.	 https://drive.google.com/file/d/140tSAlUWQBxAK_2kszjjSI3GFwGUsus6/view?usp=sharing
		  b.	 https://drive.google.com/file/d/1UwsNr1SRPVxEXz1hN02M7UdUZjmC630F/view?usp=sha		
			   ring	  

2.	 Click on the three dots in the top right corner to open the menu. Click on "Import Manager" > "Local SD".

3.	 Navigate to the folder containing the two downloaded files from step 1 and select both files.

4.	 A popup-window will appear after a few seconds. Select "Zipped DTED directories" as import method for dted		
	 leel0.zip

5.	 Click on the map symbol in the top toolbar to select a map type.
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1.	 Click on the arrow in the bottom right corner. Click on "Select Area"

2.	 Choose one of the selection tools from the popup window and mark the area which you wish to download.

3.	 Select the resolution for the offline maps with the slider.

4.	 Click "Download"

5.	 Select "Create a new tileset" in the popup-window. 

8
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Using ATAK with Vector/Scorpion

1.	 Make sure to go through AMC-Settings, ATAK-Settings and Video-Settings first.	  

2.	 Connect the vehicle to AMC.

3.	 In ATAK, click on the three dots in the top right. A menu will appear. Click on "Settings" and then "Network 
	 Connections". A popup will appear. Click on "Network Connections". Check that the Primary IP Address is in the 
	 range 172.20.XX.XX. 
	 NOTE: If the Primary IP Address is in a different range, disconnect from the WiFi or cellular network.

4.	 As soon as the vehicle has GPS-lock, the position as well as the sensor point of interest will appear on the map. 
	 NOTE: If the vehicle is on the ground, the sensor point of interest may not be visible.

5.	 Click on the video icon and select the stream previously configured in the ATAK configuration. 
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Markers

1.	 Select the marker icon in the ATAK top toolbar.	  

2.	 A menu with four different markers will appear on the right side.

3.	 Select the desired marker and click on the map to place the marker.

4.	 Click on "send" in the bottom right menu. You can either send the marker to a particular device or broadcast it.

5.	 The markers will appear in the map in AMC (Fly View only).

8
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9. SILVUS HANDLING

Silvus Handling

9
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Antennas

Monopole Antennas

Monopole Antennas, such as the ones mounted beneath the Vector and Scorpion fuselage, consist of an antenna monopole. 
As a single pole antenna is theoretically and physically impossible, a ground plane needs to be created. This is achieved by 
connecting the ground of the antenna to (in this case) a metallic foil, with an appropriately sized surface area. 
The advantages are their small size, but the disadvantage is their requirement of a ground plane. They have an omnidirectio-
nal radiation pattern.

Dipole Antennas

Dipole antennas are a simpler form of antennas. Two wires form an electrical dipole. If mounted vertically, the radiation pattern 
is omnidirectional, highest gain on the horizontal plane, and lowest gain directly above the antenna. 
The handheld ground radios use two dipole antennas. This is a good choice for easy handling and transport.
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Sources of interference

In radio transmission, there are many sources of interference, that can reduce signal strength and thus reduce performance of 
a datalink. Below is some information about the most common sources of interference, and how to avoid them.

Fresnel Zone
Contrary to intuition, radio waves travel not only directly, but also in an ellipsoidal pattern. This is visualized in below picture. 
Mounting antennas close to the ground can therefore reduce signal strength by partially blocking signal transmission. As a 
countermeasure, e.g. for achieving long distance, mounting the radio or antenna on a pole may increase signal strength.

Silvus Handling

9
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Geographical Influence
When flying long distance missions, it is important to recognize the scale of the geographical influence. Below graphic is a true 
to scale representation of the distance, altitude and angle of a long-distance radio signal path (simplified without Fresnel zone). 
The angle of the signal path is very low, therefore objects in the way can have big negative impact on the signal strength 
(e.g. trees close to the ground radio).

At such distance, the earth’s curvature can decrease the effective height of the antennas. Think of the horizon you can see at the 
seashore. It is roughly 5km (or ~3 miles) away from the viewer. At 20m above ground this distance increases only to 17km (~11 
miles). Having this in mind regarding antenna positions (either fly high, or mount ground radio on antenna pole) can greatly 
increase performance.

600 ft

7500 ft

7500 ft

600 ft
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Weather Influence
Water particles in the air cause diffraction, reflection and scattering of radio waves and hence attenuation. Therefore, it should 
be noted, that in misty conditions, high humidity or rain, a reduction of signal strength needs to be accounted for.

Noise
Noise is considered unwanted radio frequency electrical signals. The frequency, magnitude and source of noise can differentia-
te, yet commonly reduce the signal-to-noise ratio and thus the received signal of a transmission signal.

Imagine trying to converse with your partner in a busy restaurant, but your partner is sitting on the other side of the room. You 
either need to raise your voice or silence the other people. Both ways are rather tedious. In the radio domain, a common way 
to evade noise is to switch frequency or avoid noise polluted frequencies. In our restaurant domain, this would mean to either 
speak in a very high pitched or very baritone voice. 

Noise pollution can have different sources, but most common are the unmanaged frequency bands, such as the Wi-Fi (2.4 GHz) 
or comparable bands (833MHz, 500MHz). But heavy electric machinery (generators, electric motors, big DC/DC converters) can 
also create electromagnetic interference that creates noise. Try to stay clear of noise polluted frequencies. The Silvus radio is 
capable of switching frequencies.

Silvus Handling
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Isolators
In certain conditions, metal objects near the antenna can reduce, isolate, or block the radio signal. In most cases, the operator 
should try to avoid any metallic object in the vicinity of the antenna. A metal container or vehicle in the line of sight to the UAV 
can block the transmission completely in the worst case. A good way to get out of the influence of metal parts is the use of an 
extendable antenna pole. 
Other objects to avoid: Metal railings, heavy metal concrete structures, high voltage pylons, etc. Ask yourself what around you 
can conduct electricity. If there is a lot, try changing position.
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Signal parameters

RSSI
RSSI is an abbreviation and stands for “Received Signal Strength Indicator”. The RSSI is a measurement taken by the radio re-
ceiver and indicates the received signal strength.

SNR
The Signal to Noise Ratio (SNR) compares the communications signal level to the background noise level. The SNR is a crucial 
indicator of the connection quality.

Signal Bandwidth
The signal bandwidth with Silvus radios can be adjusted between 5Mhz, 10MHz or 20Mhz. Generally, a greater signal band-
width increases throughput and traffic performance, but reduces SNR due to higher susceptibility to noise. Due to this fact, try 
reducing bandwidth in noisy or long-range conditions. If you have a high traffic load and larger network, a greater bandwidth 
may increase performance.

Silvus Handling
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Best practice

Example use case (One Ground Radio – One Air Radio)
The following points describe a use case in which the conditions are set to be optimal. This includes

•	 Ground antenna/radio mounted on a pole or tripod, with the antennas pointing up (vertical), at least 2m off 
      the ground, and far away from metal objects such as cars, containers, railings, etc.
•	 The UAV is flying high enough, the line of sight of the datalink to the UAV is unobstructed
•	 The mission distance is kept adequate in order to have a reliable and strong enough signal
•	 Noise sources are kept at distance (Wi-Fi, Bluetooth, other EM Interference sources) or on other frequencies

High distance use case
As mentioned, for high distances, following measures can increase stability and performance of the datalink and signal 
strength

•	 High gain ground antenna: Using this in combination with a high mounting point, and the antenna directed 
      towards the mission area, the signal can be improved significantly. 
•	 If the signal has good RSSI, but low SNR, try reducing the signal bandwidth. Less signal bandwidth reduces 
      susceptibility for noise, thus increasing SNR and performance
•	 Try reducing network size, in best case to a one-to-one connection. This reduces airtime and gives greater 
      performance to beamforming. Try to distribute the traffic via Ethernet network using the Silvus node as edge 
      node (this setup is also known as wired backbone).
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10. VIDEO STORAGE

Video Storage
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Video storage

The vehicle does not store videos onboard the aircraft. Rather, videos are stored on the Skynav controller. To view stored vi-
deos, select  the   AMC Menu on the top-left, and then select Photos.

Thumbnails of videos taken during flight will appear in the Photos screen. To access the Windows directories where videos 
and photo files are stored, select the file folder icons at the bottom of the screen. 
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11. UPDATES  

Updates
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Updates 

1.	 Download the latest Auterion Enterprise PX4 software release from Auterion Suite.
a.	 https://suite.auterion.com/
b.	 Downloads > Firmware.
c.	 Close Auterion Mission Control if it is currently running on the laptop or computer.

2.	 Power on vehicle and connect USB-C cable
	 Only the vehicle main body is needed.

3.	 Open your internet browser and navigate to http://skynode.local/
	 This connects to a local web server on the vehicle. If the URL listed above does not work, navigate 
      to http://10.41.1.1 instead.
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4.	 Click Browse files... to select the software image (example name "aepx4-v2.1.auterionos") with the new release 
                and then click Update. File name should have the .auterionos extension.

5.	 A progress bar will indicate the file transfer progress. On completion, the vehicle will automatically reboot and verify
                the update process. The complete update process can take up to 5 minutes. Wait until the vehicle has rebooted and 
                a successful update is confirmed. 

11
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Updating the Smart Battery Pack

Update harness

Reset pinIn order to do the SBP Update a special program is needed. The program 
will be provided with every update via email. The program is designed to 
run on Windows computers. 
Note: The update process requires a fully assembled Smart Battery Pack.

1. Please connect the update harness to the battery.
2. Please reset the battery with the reset pin.
3. �Choose the correct COM port until the "Update firmware" button is  

available.
4. Please select "Update firmware".
5. The process is completed when "Success: Verify complete" is displayed.
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12. TROUBLESHOOTING

Troubleshooting
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Troubleshooting and failsafe-settings

Setting Return to Launch (RTL) Height
Before each flight, carefully consider the best Return to Launch Height in           > Vehicle Setup > Safety. RTL height is relative 
to the launch location’s elevation. Therefore, you must consider ground elevation differences in the mission area, as well as 
trees, buildings, and all other tall obstacles.

Within reason, the RTL Height should be set as high as practical and in accordance with local airspace restrictions. A high RTL 
Height increases the probability that link between the vehicle and ground station will be regained once the vehicle climbs 
to the RTL Height. Additionally, a high RTL Height minimizes the probability of terrain and obstacle impacts enroute to the 
Launch location. However, setting the RTL Height too high also has downsides – namely, climbing to an extremely high RTL 
Height might spend and undesirable amount of battery life. Weigh these factors and choose an appropriate the RTL height 
given the specifics of each mission.
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Troubleshooting

LOSS OF LINK

AMC Warning Message
•	 Manual control lost

Possible Cause
•	 Silvus battery empty 
•	 Skynav battery empty
•	 Disconnected cable to Silvus
•	 RF interference, no line of sight from radio to vehicle, jamming, or exceeding maximum RF range

Automatic System Behavior
•	 Vehicle holds for 30 seconds at present location, then Returns to Launch and lands.

Recommended Operator Actions
1.	 Ensure Skynav and Silvus ground radio cables are firmly connected.
2.	 Ensure Silvus ground radio is powered on (set to position 1).
3.	 If Silvus battery is flashing red, replace/charge Silvus battery. 
4.	 Ensure Silvus ground radio antennas are firmly screwed in.
5.	 Ensure good line of sight between ground radio and vehicle.
	 a.	 Clear any personnel, vehicles, or obstacles in between the ground radio and the vehicle.
	 b.	 If possible, relocate to an area with better line of sight.
6.	 Wait for link to return.
	 a.	 If link does not return, the vehicle will land at the launch location.
	 b.	 If link does return, either let the vehicle land or re-task it, as desired.

12
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LOW BATTERY

AMC Warning Message
•	 Remaining flight time low, returning to land

Possible Causes
•	 The system predicts that given the battery level and distance to the landing point, the battery level will be below 10% 	
	 upon landing.

Automatic System Behavior
•	 Vehicle executes Return to Launch at the user-specified Return to Launch Height.

Recommended Operator Actions
•	 Allow the vehicle to RTL, so that it does not run out of battery and crash.

HIGH WIND WARNING

AMC Warning Message
•	 High wind speed detected (12 m/s), landing advised.

Possible Causes
•	 Vehicle measured wind speeds above 12 m/s (23 knots).

Automatic System Behavior
•	 None, this is just a warning.

Recommended Operator Actions
•	 Avoid areas prone to high winds and turbulence, if possible. If the vehicle is unstable or uncontrollable, select Return 
	 to Launch.
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Troubleshooting

RETURN TO LAUNCH DUE TO HIGH WIND

AMC Warning Message
•	 Too high wind abort operation and RTL

Possible Causes
•	 The vehicle measured wind speeds above 15 m/s (29 knots). 

Automatic System Behavior
•	 Vehicle Returns to Launch at the user-specified Return to Launch Height. 

Recommended Operator Actions
1.	 If possible, fly into an area with less wind.
2.	 Landing is the most wind-critical phase of flight, so if conditions are likely to improve, stay airborne and wait for 
	 conditions to improve before landing (consider using Orbit or Hold while waiting for conditions to improve).

GEOFENCE PROXIMITY WARNING

AMC Warning Message
•	 Approaching on Geofence

Possible Causes
•	 Vehicle is approaching a user-defined Geofence.

Automatic System Behavior
•	 Automatically commands Hold (orbits at present location) near the edge of the Geofence.

Recommended Operator Actions
1.	 Fly away from the Geofence.
2.	 If acceptable, modify Geofence to allow continuation of mission.
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ESC HIGH TEMPERATURE WARNING

AMC Warning Message
•	 High ESC temperature, landing advised (85°C or 185°F). 
   

Possible Causes
•	 High ambient temperature.
•	 Long hover period (does not apply for Scorpion).

Automatic System Behavior
•	 None, this is just a warning.

Recommended Operator Actions
•	 Land as soon as possible. 

ESC CRITICAL TEMPERATURE

AMC Warning Message
•	 Critical ESC temperature, vehicle will descend

Possible Causes
•	 High ambient temperature.
•	 Long hover period (does not apply for Scorpion).

Automatic System Behavior
•	 Vehicle will descent. It no longer allows slowing of descent speed during landing.

Recommended Operator Actions
•	 Land as soon as possible.
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Troubleshooting

AIRSPEED FAILURE

AMC Warning Message
•	 Airspeed sensor failure detected. Return to Launch is advised.

Possible Causes
•	 Sensor disconnected
•	 Sensor malfunctioning
•	 Pitot tube is blocked

Automatic System Behavior
•	 System switches to non-airspeed-sensor-mode. It flies faster, is less battery efficient, and is less robust against 
      disturbances.

Recommended Operator Actions
•	 Land at current position.

AIRSPEED SENSOR FAILURE IN CRUISE FLIGHT

AMC Warning Message
•	 Airspeed sensor failure detected. Return to Launch is advised.

Possible Causes
•	 Sensor disconnected
•	 Sensor malfunctioning
•	 Pitot tube is blocked

Automatic System Behavior
•	 System switches to non-airspeed-sensor-mode. It flies faster, is less battery efficient, and is less robust against 
      disturbances

12
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Recommended Operator Actions
•	 Return to  Launch if possible. 
   

INVALID GLOBAL NAVIGATION SATELLITE SYSTEMS (GNSS) SIGNAL WHEN IN CRUISE (MISSION OR HOLD MODES)

AMC Warning Message
•	 Failsafe enabled: no global position

Possible Causes
•	 Sensor malfunction
•	 GPS denied area

Automatic System Behavior
•	 Phase 1: If GPS is lost for more than a few minutes (exact time is variable based on sensor state), then the Vector 
                       will switch to a failsafe mode where it executes an orbit at its current altitude using a fixed bank angle to 
                       stay roughly in the same orbit location. It does this for 5 minutes.
•	 Phase 2: Vector transitions to VTOL hover and descends to land.

Recommended Operator Actions
1.	 The operator can allow the Vector to eventually land automatically if all locations beneath the orbit path are suitable
      for landing.
2.	 If the operator identifies with the Vector’s camera that only one spot on the ground beneath the orbit path is suitable
      for landing, the operator can command EMERGENCY LANDING above that position and attempt to use the 
      joysticks to nudge the Vector to the desired landing location as it descends. 
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Troubleshooting

INVALID GLOBAL NAVIGATION SATELLITE SYSTEMS (GNSS) SIGNAL WHEN IN POSITION FLIGHT MODE

AMC Warning Message
•	 Failsafe enabled: no global position

Possible Causes
•	 Sensor malfunction
•	 GPS denied area

Automatic System Behavior
•	 Automatically switches to Altitude flight mode (not a user-selectable flight mode). Altitude mode functions 
      almost exactly like Position mode, but Altitude mode maintains heading while Position mode maintains course.

Recommended Operator Actions
•	 Manually fly the Vector toward the landing location, manually descend to 164 feet (50 meters) or below and execute
      an EMERGENCY LANDING in the EMERGENCY ACTIONS menu.

INVALID GLOBAL NAVIGATION SATELLITE SYSTEMS (GNSS) SIGNAL WHEN IN VTOL/HOVER 

AMC Warning Message
•	 Failsafe enabled: no global position

Possible Causes
•	 Sensor malfunction
•	 GPS denied area

Automatic System Behavior
•	 Vehicle automatically switches to Land mode and descends at current location.  
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Recommended Operator Actions
1.	 If landing area is clear, do nothing. Allow the Vector to land.
2.	 If landing area is not clear, use the joysticks to better position the Vector for landing within a 20 meter radius. 
      Note that the Vector cannot climb or maintain altitude in this case. It will descend at a minimum of 0.5 m/s. 
   

MAG INCONSISTENT
Vehicle heading on the map and in the telemetry box does not match actual heading. AMC will say “Perform Quick Compass 
Calibration”. 

1.	 Move vehicle away from any objects generating magnetic/electromagnetic fields (generators, other antennas, 
      transformers, power lines, etc.).
2.	 Move ehicle away from objects containing large amounts of metal.
3.	 Perform a Quick Compass Calibration by rotating the vehicle 360 degrees horizontally several times (ensure inner
      wings are installed).
4.	 If the headings still don’t match, conduct a Compass Calibration in           > Vehicle Setup > Sensors > Compass. 
      Ensure the right inner wing and left inner wing are installed during calibration. Do not install the outer wings.  

NO GPS LOCK
1.	 Ensure there are no overhead objects obstructing a clear view of the sky.
2.	 Move Vehicle away from any objects generating magnetic/electromagnetic fields (generators, other antennas, 
      transformers, power lines, etc.). 
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Troubleshooting

NO CONNECTION BETWEEN VEHICLE AND AMC
1.	 Ensure Silvus data link is powered on and on profile 1.
2.	 Ensure cable connections to the Skynav tablet are correct.
3.	 Ensure vehicle is powered on, and radio profile selector is set to 1.
4.	 Wait 90 seconds. If there is still no connection, power cycle the vehicle and wait another 90 seconds.

AIRSPEED INVALID
1.	 Disconnect airspeed sensor. Inspect connector for damage and dirt. Inspect tube for damage and obstructions. 
      Re-install airspeed sensor.
2.	 Power cycle Vehicle.

NO VIDEO OR POOR QUAILTY VIDEO STREAM
•	 Power cycle vehicle.
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